POINT CLOUD PROCESSING

Software:
Power GEOPAK V8i (SELECT Series 4)
TerraScan Version 017.001
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Intent

The intent of this document is to provide insight to the process and workflow behind editing and
utilizing terrestrial LIDAR data in the form of a .las.

Preparation

This document assumes that the data is preprocessed and exported into an open source native point
cloud format. For example, using the Leica ScanStation, the data is exported out of Infinity in a .las
format (used in this demonstration). Additionally, this document assumes the user has access to remote
desktop connection (to utilize a license of Terrascan).
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Leica Infinity

Opening a Project in Leica Infinity

Option 1: Open Infinity and select New Project. In this window, you will name your project and choose
your folder destination. You will also want to define your units and coordinate system at this time. Once
everything is filled out, click Create.

X\Employees\mobiryanprojects\Misc\Survey Training] Residual Distribution  None

WG58 Geodetic &
WG58 Cantesian (=

Option 2: If the project was previously created, you must register the project before you can open it. To
do this select Project Manager, then select register and browse to your .IPRJ file. Your project will now
be in the list of projects under Project Manager.

Manage Infinity Projects

= Losd il Delete. Uncegister | Register Order by: | Last Accessed - ¥ Q

g 5 o Cloud eing
Xm

Misc\Survey Trai..\Survey Peint Clad Training ipsj
208 MB

fcesssed 112772017 140327
Created 1Y27/2017 140327



Importing Raw Data

Under the Home tab select the Import button, a new window will appear. Browse to wherever you
placed your raw data. Select the DBX file (Format = SmartWorx) and click Import on the dialogue
window. This will bring in all your control as well as all your completed scans.
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Leica Exchange
4 Details for SURVEY TRAINING

Job Name SURVEY TRAINING
Job Description SCAN EXAMPLE
Created by DEO

Size 450 kB

Modified 11/21/2017 14:20:24
Coordinate System  OHIO SOUTH NADE3
CAD files attached  No
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Google Earth Check

Much like Trimble Business Center, Infinity allows you to quickly view your data in Google Earth. This
is typically the first step once you import your raw data to quickly verify that your data is in the correct
location. Under the Home tab click Google Earth

Processing  Surfaces  Scanning  Imaging  Adjustments  Features  External Services

~ - L q
L & B |@©@ A 2 g I I~ S o S R 7 I, & %
—_ = — & . . ) 5 Thematic Codes ~ e = - ’? £ 4 . i
Import Export Reporty Google Point  Station Observation Layer HxlP Link Unlink Clip  Georeference Measure Shift, Compute Coordinate
- Earth Manager Referenced Files = - - Base Map Image Paint to Point Rotate, Scale | Project Coordinates System Manager
Data New Layers Base Map Images COGO Coordinates
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Fixing a Wrong Setup

From this data, you can see that one of the scans if rotated 180 degrees. This is due to choosing the
wrong setup point and wrong backsight point. For this example, the first scan was incorrect. We
selected our setup point as GS2 and backsight point as GS1 however, they should have been reversed.
To fix this, click the inspector tab and then the TPS tab, make sure the TPS Observations by Station
Source is selected. This will list all your setups including your “backsight checks”.
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TPS Setup

Next to the first wrong setup select the edit (pencil icon), a new window opens. Our current Station
Point Source is GS2 when it should be the control point GS1. To fix this, select the edit (pencil icon)



Setups * >

| Station 1| Point Role Y‘ File Source 1['| Setup Method Y| Instr. Height [ftUS] ‘ Northing [ftUS] ‘ Easting [ftUS] | Ortho. Height [ftUS5] ‘ Geoid Separation [ftUS] | Station Scale | Instr
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A new window appears, select the appropriate control point (GS1).
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Cancel

Click next in the Edit Setup window. This is the Setup Observations window. This is where you can
select a certain point to use for the setup. For this data set there is only once choice so click next at the
bottom of the window. You are now in the Compute Setup window. In this window, select your target
point. For this setup, we should have chosen GS2 as our backsight. To fix this select the edit (pencil
icon) and choose the correct control point GS2. Click Finish. The next Setup Station is from when we
checked our backsight. We must also fix this setup using the same method above. Once completed this

will adjust your scan and rotate it correctly.
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Since we had multiple Total Station setups label GS2 we must fix the second scan as well. We will be
replacing the total station setup with the correct control points. The steps are similar to the previous 2
setups however you are choosing GS2 as the setup point and GS1 as your known backsight point. Like
before click the edit button next to GS2 (third one down) in the Inspector Window. Then click the edit
button next to Station Point Source within the Edit Setup Window. Now select GS2 as your control
point.
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Click next in the Edit Setup window. This is the Setup Observations window. This is where you can
select a certain point to use for the setup. For this data set there is only once choice so click next at the
bottom of the window. You are now in the Compute Setup window. In this window, select your target
point. For this setup, we should have chosen GS1 as our backsight. To fix this select the edit (pencil
icon) and choose the correct control point GS1. Click Finish. Once completed this will adjust your
second scan and rotate it correctly. Our blown backsight will now be fixed and we can proceed.
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Backsight
== [] Apply scale to observations
Station Point Id G52
Instr. Height 5.510 ftUS 4 Tolerances
Date/Time 11,/21/2017 Target Position Limit Target Height Limit
09:58:01 [] |0.033 frUs [] |0.033 fUs

Instr Type MS50 1" R2000
Instr SN 260016 Back || Finsh || Cancel

Preliminary Data Clean-Up (Use with Caution)
An easy way to reduce the size of your point cloud is to delete the unneeded points. For this dataset, we
can see that there are point’s way out from the building. To delete these points, click the scanning tab.
As a note, you cannot zoom in and out when selecting your data because your selection window does
not correspond. So, make sure you are zoomed in to what you want to see. You can also change the view
that you are in by selecting the middle view icon at the bottom.
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To select the data hold shift, click and drag around your section (It will turn green when selected). You
can also hold shift and click to create a polygon around your selection. You can then click to cancel or
click delete along the top ribbon to delete those points. This should only be used as a preliminary
option. Other tools such as Terra Scan are much more powerful and accurate when dealing with editing

point clouds.
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Exporting to LAS

Once you have finished reviewing/editing your data you are ready to export a LAS. Under the home
tab, select Export. A new window opens. Browse to where you want to store the Las file. Choose LAS as
your format and click export. This will export all scans into one LAS file. You can also select part of the
data using the selection process aforementioned. When you have, data selected you have the option to
export all or export selection when you click the export button.
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Remote Desktop Connection

To utilize the Terrasolid suite of products remote desktop connection needs to be used. The software is
licensed on a single computer located in CADD and Mapping Services (due to how often the software
will be utilized compared to the price). This poses a small challenge due to the fact only one person can
be logged in at a time. Fortunately, the process takes 10 minutes or less so if by chance someone is
remoted in the process should not take long. It is imperative that the user disconnects from the remote
connection once the process is completed to allow other users the opportunity to use it

TerraScan Point Cloud Editing

Establishing the Remote Desktop Connection

53!

Under the start menu click All Programs - Accessories > Remote Desktop Connection

P - |
& Windows Mobile Device Center rg/*
£ Windows Update
4 XPS Viewer Documents
Accessories :
[z] Calculator Computer
E¥ Command Prompt
@3 Connect to a Network Projector |~ [RELIEGTEELE
B8 Connect to a Projector
| Getting Started @ Devices and Printers
117 Math Input Panel
| Notepad
“at Paint
_ ™ Remote Desktop Connection.
5] Run

Help and Support

Run...

’%. Snipping Tool

L Sound Recorder

" Sticky Notes

@ Sync Center

4 Windows Explorer
= WordPad

Back

A dialog box will appear to locate the computer you would like to remotely connect to (see next page)
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| Remote Desktop
»¢) Connection

Computer: ENO311407 -
Username: DOT Kince

You will be asked for credentials when you connect.

{> Show Options [ Connect J[ Help ]

L e

The computer name you are trying to remote into is CEN0311407 and your user name will appear in the
section below.

Once selected click the Connect button.

A windows security dialog box will be displayed and the user will need to login using their ODOT
credentials (same as the user and password to log into the computer)

-

Windows Security 2

Enter your credentials
These credentials will be used to connect to CEMN0311407,

DOT\Kince

| Password

@

Use another account

3

| ok || Ccancel

L

-

Click OK to continue.

You are now logged into the computer and an ODOT Computer & Internet Use Policy screen will appear
click ok to continue.

Note: If you are using dual monitors the computer only remotes into one screen the other screen will be
the user’s computer.



Opening Microstation

Open Microstation (either standard is fine a .dgn won’t be created during this process).

Id 2
OO Teadd
Microstati,.,

Open a generic 3D design file (the same file can be used repeatedly because no elements will be created
in the .dgn)

When opening Microstation a popup window might open with a message about precision, this window
can be ignored.

Starting Terrascan

Terrascan is an MDL application that is run within Microstation (not a tool but more of a plugin which
uses the Microstation interface)

To start the MDL, select Utilities > MDL Applications

wolz | Utiities | Cadig  ‘Workspace &g
Y Kew-in
3D W arghouse 3
Connect Web Browser LI

HTML Authar...
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i
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—h £ Image 3
Bender 3
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Salar Analyzis 3
Froperty Filter...
;‘;J Itern Sgts

Design Histany 3
4 Batch Carveerter..
. Batch Process...
i Standards Checker 3

Packager...

Data Cleanup
v oad Dimension Audit
Licenze Matnagement...

Sled Macra 3
4 MDL &pplications




An MDL dialog box will appear (depicted on the next page) under the Available Applications section
select the TSCAN task ID and then click load. (The MDL window can be closed)
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TerraScan opens two windows (shown below).
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Using the Main toolbar (depicted in the above photo in red) select File > Read Points

Select the file you wish to load and open (a .las file is the standard and best format to use)

Load Points dialog box will appear (Use the default settings) and click OK to load the data.



Running a Macro for Auto-Classification
To run a macro on the loaded points you can utilize pre-written macros or create your own using the
macro tool.

First, in the main toolbar, select tools=> macro

’“ Terra%can - 0 points E'E'@

File  OQutput Point  Yiew Classify | Tools | Flightline

Showy statistics..,

Drawy bounding box

- Drrav inta praofile..,
Show location - P

Drrawy into sections...

The macro window will open.

H bacr o=
File  Run
Deseription? || [ Frocess flightlines separately Step
Author: [7] Process scanners separately
dudd...
Inzert...
Edit...
Delete
Move up
Move down
Under File select Open.

Browse to the .mac macro file that is pre-written or skip these last steps and add steps using the macro
tool.

To run the file on the entire loaded point cloud select Run-> On loaded points
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The macro will run through the entire script.

*To step through the script, use the Step button located in the top right of the macro tool.

Manual Editing

Within TerraScan there are a few tools that allow the user to manually edit the point cloud for those
points which might not be classified correctly or the user wishes to not include in the ground (or tin).

To visualize the data in the most efficient manner the display mode tool can be used.

Under the view tab in the main toolbar select display mode

B Displaymode [ = | & [
Wiew: Eit
Caolor by: | Clazs | [ Colors... ]
(™
weight [— |
Lines:
Dims:
Speed: [Momal - all points |
[] Use depth
Al0n | | O Defaul =
@ Ground
O “egetation-Misc =
O Medium Vegetation
O HighVegetation
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O Low Paint
AIBE 1 3 High Paint -
[ hppiy | | Allviews | B WP




Chose the view you are displaying the points in (or all views) and under speed select normal all points
(to ensure all the points are displayed)

Turn off all the classes and select the ground class. (This will only display the ground class so when the
user is using the brush tool it will appear as if the points are getting deleted but instead they are being
reclassified and placed in a different class).

TIP* Under the view tab in the main toolbar there is a fit view tool this will fit all the active points to the
view the user clicks inside. (As opposed to using the global fit which will fit everything in the drawing)

Classify Brush
Next open the classify using brush tool

To open this tool the model toolbar needs to be opened. (TerraScan tool bar boxed in red on the next
page.)

TerraScan - 0 points
File  Output  Point  Yiew Classify  Toolz  Flightline

To undock this toolbar to easily expand click and drag the toolbar out of the docked position.

kadel
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The picture above is the toolbar undocked.

The “classify using brush” tool s opened by clicking on the icon.

) Classify Using Brush El =] @
{Fram: |.-i‘-.n_l,l vizible point - | =
Eruzh zhape: |Circle - |
Bruzh size: | 20 pivels
Toclazs: |'I - Dietault - | =

Note* a tip for ease of use is to increase the brush size to 20 pixels.



To use the tool the user can click to turn the brush on and click to turn off or click and hold to keep the
brush on until the left mouse button is released and simply “brush” over points that need reclassified.

A best practice is to rotate the point cloud onto one side to look at the surface level to find the points
that the algorithm misclassified.

Vertical Cross Section Tool

The vertical cross section tool is very useful for editing large detailed point clouds in conjunction with
the brush editing tool. To open this tool, utilize the TerraScan Toolbar and click and hold the A-A
section button (to dock, click and drag to the location you would like to dock).

Terralcan - 0 points
Fil= Output  Point  Wiew Classify  Toolz  Flightline

Wigwe Laser

E
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To “cut” a cross-section select the A-A tool
Data click once to start the cutting plane and data click a second time to define the width of the plane.
A third data click depending on the settings will give the section’s depth.

TIP* A max section of 10 ft. is recommended (bridges require a smaller depth).
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) Drawy Vertical Section E = @

Depthi ;| 2.2

Applyto o | Miew 4

Using the Draw Vertical Section dialog box a depth can be prepopulated (if the check box is on the user
does not need to define a depth.

A fourth (or third if the depth box is checked on) data click will pick which Microstation window the
section will be drawn in.

The user can now utilize the classify tools to classify the section. Once completed the user can “walk”
through the data using the move section tool (boxed in red) and repeat. A left click advances the section
while a right click will move to the previous section.

Wiewe Laser

]
=43} ¢ Famam

Scaling Point Clouds
This guide will cover two different methods for scaling point clouds. One is for grid to ground
applications and the other is for unit changes (e.g. meters to feet).

Custom User Defined Transformations

Under the TerraScan toolbar click on the TerraScan settings button.

TerraScan - 0 points
File  Output  Point  Yiew Classify Toolz  Elightline

A dialog box will open.
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Under the Coordinate Transformations select Transformations.
For some users, a couple custom transformations may be registered already.

If the unit change transformation is not there (e.g. Meters to US Survey Feet) simply click the add
button and select the linear transformation type. Then Click OK to save.

Transformation

Mame: | [ZEED

Type: [Linear x|
b Liltiply by Add congtant
w 3.28083333 ¥ | 000000
Yo | 3.28083333 Yo | 0.00000
£ | 328083333 Z: | 0.00000

i}

If the Scale about 0,0 is not there simply click add and select the Xy Multiply transformation. Then click
OK to save.




Transfarmation
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Type: [y muliply
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+ | 100002333030
+ | 0.00000000000
+ | 1.00000000000 | "5z
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| Cancel |

*Please note that every project you are trying to scale will need to have this updated and saved with the

appropriate scale factor.

Applying Transformations

This workflow will be very helpful when exporting point cloud data out of Leica Infinity (even if the
project is in feet the data will export in meters) or when a point cloud needs scaled to ground after the

fact.

With a loaded point cloud, under the main toolbar select Tools—> Transform Loaded Points.
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Transform points

Class: |&ny class - | m

Elightline: | 0-65535 0-65535 for all
[] Inzide fence onlp
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)4 Cancel

From the drop-down menu select the transformation you would like to apply. Then Select OK.

Exporting Processed Point Clouds

When exporting (saving) points out of Terrascan, users can save by class (e.g. ground points) or by
region created by a fence (or a combination of both).

To save your data click File - Save As in the main Terrascan toolbar.

The Save Points dialog box will open.
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Select the classes you wish to export and if using a fence click on the Inside fence only selection box.
Click OK.

A standard windows file save dialog will open. Browse and name the file then hit save.
A dialog will appear showing how many points were written to the file.

Please close out of the remote desktop connection when finished with this step.



3DReshaper

3DReshaper is a powerful tool for creating mesh surfaces, volume calculations, and change detection
models from point clouds.

This section of the guide assumes the data has been edited and exported out of Terrascan or a similar
product in a .las format.

Loading Point Clouds Into 3DReshaper

After opening 3DReshaper select the file menu button located in the top left.

Impart File(s)
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Import Cloud(s)

Import cloud(s). Several cloud files can be
imported together
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Import Meshies)
Import mesh(es), Several meshes can be

Impart 4 imported at the same time
Import Point(s)

Export b m:[:]rt point(sl.Import a list of points from ascii
Import Polyline(s)

Send To 4 Import polyline(s): contour(s), section(s) from

ascii file[s)

ﬁ Import CAD object(s) - IGES/STEP
Impart IGES-STEP file

Import Project(s)
Save As D Import Project from DXF, DWG or XML file[s)
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Export to 3D PDF
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Go to Import - Import Clouds and select the point clouds you would like to import.

The Import Clouds dialog box will appear.



Click the Add button to add file to the list below. You can also drag/drop the files from the
explorer,

¥ \Employeesimobryan‘projects \District 9\AC-35-6, 32-POSTJAC-35-6,32F Add. ..

Configure...
Delete

Delete all

[ Reduce point doud(s) to a given number of points (in million)
This reduction is only available on blue files.

][ Cancel ]

Click ADD to browse to the point cloud you would like to import. Uncheck the Reduce point cloud(s) to
a given number of points box to retain the detail of scan.

Click OK to begin the Import.

Creating a Mesh

Once the desired point cloud data is imported expand the cloud group in the 3DReshaper Tree
(typically docked on the left side on the window).

Filter objects... E
pud Group ::)—
" JAC-35-8...- Ground i;l'- r
> Coordinate System -,l:;?:
> ﬁ Recycle bin

Select the file or files to be meshed
Under the Mesh tab located in the tool ribbon select the 3D Mesh tool.

Construct

Transform Cloud

O 2D 2D Mesh
ﬁ} Join 2 Contours
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esh Meshing

Z} |
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Once selected the 3DReshaper Tree will turn into the 3D Mesh Creation toolbar on the left side of the
window.

Paint doud property Toggle the Noise reduction parameters to Meshing in two
Nb of points 5797020 steps and (depending on the spacing of the scan) set the
B average distance between points (the default typically works
ﬂ Moise reduction well).
(@) Meshing in two steps .
= _ In the Hole management section please toggle the create
o O Reguiar samping watertight mesh on.
8 Average distance betw;en 2 41567
S points * Certain applications of meshing will require the hole
- Hole management detection method be used (e.g. beam modeling). If not the
b © Hole detection mesh will enclose itself in areas that do not accurately
= represent the beam.
(]
€3 (O Try tokeep only the external border ** It is best practice to utilize the Preview function then select
® Try to create a watertight mesh OK to move onto the next meshing step.
Select OK
The 3D Mesh Creation toolbar will turn into the Refine Mesh
from a point cloud toolbar.
e OK l [ ks Preview l [ m Cancel l
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Mesh generation method

[Interpolate new points v]

= Refine with point
= evenly spaced Deviation
error

@ Refine with deviation
=~ error 0.0d

Maxi number of triangles 10000000

Minimum triangle size  0.02

Qutlier point distance 0.1

Local recrganization

Hole management

Refine Mesh from a point cloud @ @

() Mo free border modification

(@) Extend free border

(") Refine free borders

[ k) Preview I [ ﬁ Cancel

0K, Mext Ok, Exit

The second step of the mesh making process
involves the refinement of the initial mesh created
in the previous step.

In the Refine mesh from a point cloud dialog
define the “refine with deviation error” (the smaller
you go the more detailed the mesh will be but the
file size will grow exponentially).

*A best practice would be around .02

For the Max number of triangles for large areas
this number can be increased.

A minimum triangle size is driven by the scan
density (generally set it smaller than the scan grid).

The defaults for the rest of the settings provide
great results.

Select the preview button to check the settings.

If the result is acceptable press the Ok, Exit button
to finalize the mesh.



Exporting a Mesh

To export a mesh, expand the Mesh Group in the 3DReshaper Tree and select the mesh you wish to
export.

—
Filter objects... —
—

» Cloud Group L |

“ Mesh Group =

| L 7] Refined ... Ground g )

> Tl Ie bin

Once selected click on the file select button in the top left (red) of the window and browse to the export
section (blue). Select the Export Selected Mesh(es) option.

Export selected object(s)

Export Selected Cloud(s)
&¥ Export Cloud(s) for an external use

m Export Selected Mesh(es)
&1 Export meshies)
AP N Export Selected Point(s)
'zlr,l Export point(s)

Export Selected Polyline(s)

Export polylines: contour(s), section(s), etc.

I-‘? Export Selected CAD object(s) - IGES/STEP
=0 Export IGES-STEP file

Export Ortho-Image
g Create an ortho-image from the current 3D

Save As View and export it as a picture file [JPG, BMP,

Export Project in DXF file
— Frint 3

=]
@ Export to 3D PDF
. Close

Language

If you are using State Plan coordinates you will receive a message warning about big coordinates. Press
Ok to continue.



823 3DReshaper | 2 |

_ Big coordinates have been detected in the selected meshes. Other softwares may
I __I_l not be able to open the file because of this. Try to translate your mesh near the
origin if you have any trouble.

The Export Mesh dialog box will appear.

J « Employees » mobryan » projects » District9 » JAC-35-6.32-POST » Search JAC-35-6.32-POST

Organize * New folder 4= - @

i Name Date modified Type Size

M Computer
> & OSDisk (C:)
> 8 YDRIVES (\\DO6f<002) (F:)
» 5 gis (\itcfs007 dot.state.ch.us]
> CADDS (W\d06fs002) (H:)
> ¥ idrive (\itcfs007 . dot state.oh.
» ® CaddMappingSurvey (\\filest
> L SFY2011 (Vaerialarchive) (K:)
» L SFY2016 (V\aerialarchive) (L)
» L SFY2012 (\aerialarchive) (M) -

J JAC-35-6.32P0OST_1069_0014 113053 9/18/2017 T:51 AM File folder

N File name: -

Save as type: | Ascii STL (*.stl) vl

“ Hide Folders I Save ] ’ Cancel ]

In the Export Mesh dialog box change the save as type to Ascii STL (*.stl). Browse to the location you
would like to export and click Save.

This file format can be opened in Microstation and other software packages.

Change Detection Models

Change detection models are a great way to visually display and document changes that have happened
to an area (structure or terrain).

This modeling (basically colorizing) can be ran on both point clouds and meshes, utilizing the same
workflow.

To begin load in the point clouds or meshes you would like to compare.

In the 3DReshaper tree (located on the left side of the window select the meshes or point clouds in the
order you would like to compare them.
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Once selected under the Measure tab at the top select the Compare/ Inspect tool from the Inspection
group.
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Cloud Mesh Polyl e Measure ! rveying Image CloudWorx

N feee€e

it Localize Create /[ Label Label
lues || Edit Label Aspect Report

Construct Transform

Measure Volume
with mouse 24

Line Circle Round Square Plane Cylinder Spher Compare
x 4 Slot~ Slot~ X = . /Inspect (]

‘Geometry Insg tion

The 3DReshaper tree will turn into the Compare Inspect tool on the left side of the window.
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Compare Inspect e @ @

Which object should be colored ?

i@ The REFERENCE chject: Mesh 1
() The ohject to PROJECT: Mesh 2

Inspection method

@ 3D Inspection

() 2D Inspection (along a direction)

Points to ignore

Ignore points with
distance greater 253.83 Default

than:
Ignore points projected on edges

In the top section of the tool you can choose
which point cloud (or surface) the colorization
will occur on.

In the Inspection method please select the 3D
Inspection method.

If you want to filter the points down further you
can do that in the next section.

After the settings are assigned click the preview
button. This will display the results on the
cloud/surface in a preliminary visualization.

Once this is completed the colors can be edited
(if you are looking for certain changes or
emphasize certain features).

Click OK to finalize the change detection.

Below is an example of a mesh generated aerial
LiDAR change detection for reference.

undefined [ |



Volume Calculations

To do volume calculations, the user will need to have generated a pre-and post construction mesh
surface of the area in question. (The mesh surfaces don’t necessarily need to be created from point
clouds (e.g. a mesh generated from design))

With the mesh surfaces imported or generated in a 3DReshaper file, select the meshes that encompass a
volume from the 3DReshaper tree.

Filter objects...

 Cloud Group
- ¢ Final Adj... - Ground
- ¢™ JEFI-gre...- Ground
* Mesh Group
- Refined ...- Ground
- [7] Refined ...Ground 1
- [7] Refined ...Ground 2
» Contour Group
? Measure Group
“ Coordinate System

L L wcs i wo

L1

L1

deededoeee
@O

Under the Measure tab at the top of the main window select the Volume tool under measure then select
the Cubature tool. This tool will compute the embankment and excavation between two opened meshes

1’]’2 = - 3UReshaper = |JEF-/-Vc

Home Construct Transform Cloud Mesh Polyline Measure Surveying Image CloudWorx Tank CAD Script View (4

AMcOommIpOL| 2 ) @6 T Q

Line Circle Round Square Plane Cylinder Sphere Cone Compare Edit Create/ Label Label Color along Color according
with mouse - x ' Slot~ Slot~ x % : % /Inspect Color Edit Label Aspect Report || aDirection to curvature
Veasy 3

i
Volume

Filte hie
V Cloud Gr v% Cubature
‘ to Fin

Cubature

O JEF =

 Mesh Gr% = Bl Compute the embankement and
phvi excavation of two opened

meshes

E und -
FZ Refined ...Ground 2 - @
> Contour Group
V Measure Group
Z Compare...round 1
& Volume ... Ground
& Volume ..round 2
V Coordinate System
L L wcs

GG Gidie o e

Once selected the Cubature dialog will replace the 3DReshaper tree on the left side of the window.



l

Computing direction The tool is very simple. Select the
Automatic computing direction and the
@ Automatic . .
a units the volume will read out as.
) User defined input . . .
@ Select either Preview to check your settings
= or OK to Finalize them.
(48]
0
=3
O
Current unit: Wolume unit:
fit fit3 -
[ L oK ] [ ey Preview ] [ €3 cancel ]




To generate a report of the calculated volumes select the Measure tab (boxed in red) at the top of the
window and under the label section select label report (boxed in blue).

P MAESIE

3DReshaper - [JEF-7-Vol

Cloud Mesh surveying Image CloudWinrs ok CAD Script View

|)<¢

Compare Edit Localize Create/ Lab
Inspect Color ‘alues || Edit Label Asp

Transform

Measure Volume
with mouse .~

olor according

Line
o curvature

Circle Round Square Plane Cylinder Sphere Cone
2 Slot~ Slot~ i 2 54 i

Once selected the Label Report dialog will appear over the 3DReshaper tree.

Check on either all labels or only visible layers
depending on if you've created additional

labels.

() All labels @ Only visible labels

*Tip use the Preview to see if the formatting
matches your desired settings.

When finished Print to pdf (or hard copy) and
select OK to return out of the tool.

Label Report € ()

Select ViewSset Number of decimals: 3
[ Setup... ” Preview... l Export...

[ lwd OK l [ ﬁ Cancel ]




?ESHAPE R®

(‘ 4 HEXAGON
3DReshaper

www.3dreshaper.com
support@ 3dreshaper.com

Customer oDoT Product name Volumetrics
Drawing number Controller name CADD and Mapping
Services

Refined from Final Adjusted Combined Surface - Ground

Label N® 1 ; Volume above Refined from JEF7-ground-FINAL_2011 - Ground 2 and below

Excess]

val

430651

Refined from JEF7-ground-FINAL_ 2011 - Ground 2

Meas

ExcCess]

Val

1515201

@

Above is an example of a Report.

*Tip you can open a pdf in word to edit the formatting by right clicking on a saved pdf and selecting
open with word. Word will then process the data into word elements that can be manipulated.

yd*

Label N® 2 ; Volume above Refined from Final Adjusted Combined Surface - Ground and below

yd?




Microstation

Hybrid Terrain Generation

To generate a hybrid terrain consisting of conventional survey and point cloud data the following
workflow should be followed.

Workflow

Export Graphics from FB to
BE

Collect Field Data

Create a KD file and
Reference in FB

Open the BE and Delete the

Terrain Model Created from 9 *Generate Point Cloud Terrain Reference I_n the KI_) File to
Convientional Only eCreate a Complex Terrain from the the BE as Final Deliverable

Referenced FB and the Point Cloud

Terrain Model

Importing Meshes

Microstation allows for the importing of certain mesh file types. One is the ascii .stl format generated in
prior steps.

To import a mesh open a GeoPAK 3D file.
Under File select Import > STL



C:\MewMew.dgn [3D - V& DGN] - Power GEOPAK series

File | Edit Element Settings Tools Utilities Cadig Workspace GEOPAK Window Subsuface Wity ODOT  Help  TopoDOT
Ti H_j ﬂew... Ctd+N f
" Open... Ctri+0
J Close Cri+\W o G | P ﬁ: r&_ @&
| Save Ctr+S
| Save fs..
Compress 3
Save Settings Cir+F
J %3 tem Browser
% Project Explorer
[f) References
I |=3 Raster Manager
' &3 Point Clouds
Models
Publish i-model...
[ Import P IGES..
Bxport ¥ Parasolids...
InterPlot Organizer ... ACIS SAT...
IPLOT... CGM...
Print Preview Step AP203/AP214...
féd Prnt... P STL..
%2 Print Organizer CAD Files...
1 TemainModel LandXML...
Associate...
Propeties AtsEnter Image...
Ted...

la -~ .

The Choose an STL file to import dialog box will open. Browse to the .stl files you would like to import.

*Tip to be able to turn the files on and off separately use different layers when importing.

Look in:
=
=
Recent Places

Desktop
=l
Libraries

[

A
Computer
=

A

Network

Final Products Deliverad - @ =& 5]
Name . Date modified Type Size
|| PostCon.stl 10/6/2017 8:53 AM  STL File 153,110 KB
|_|PreCon.stl 10/6/2017 8:54 AM  STL File 30,776 KB
File name PreCon stl hd
Files of type [t - [ cancat |

Select Open. The Import STL File dialog box will open.



Import File: PA\Completed Projects®SFY 20018%)¢

Impart Options

Simplification: | Nene: save as Mesh |

n |'||'||'||'|1|'|
u

Merge Tolerance: | 0.0000

A

Sham Edge (degrees): | 30.0
[] Generate Report

Utilize the defaults and select OK to import the file into the design file.

This file type (using open roads tools) can be cut by cross-sections just like a terrain model and
compared to the design (for comparison after construction).

Generation of TIN from Point Cloud
**Completed using PowerGEOPAK

To quickly generate a tin from a point cloud we will be utilizing some built in Terrain Modeling Tools.

Under the Task Menu Civil Tools = Terrain Model = Create from File

The icon r&’ is located on the next page highlighted in red



Tasks * 0 X 1
- | ‘

JTasks
[ Civil Tools r

S IEREE RTR
JI-A- J_’ .-",\

% Analysis & Reporting

ﬂl General Geometry

£ Horizontal Geometry

BB vertical Geometry

Y ILE Y
L

G Py V. R
ABELYE

A “Select Files to Import” dialog box will appear.

Select the ground .las file created after editing. (The “Files of Type” filter might need to be changed to

“All Files (*.%)”)

Libraries

E,sbkl

Computer

@

Network

Lok in las - @ ? * @~ i-‘j'

= Mame = Date modified Size
= BROG2_97240_defaultlas 3/26/2015 11:12 AM 516 KB
Recent Places BRO62_97240_ground.las 3/26/201511:12 AM 11,456 KB
m BROG2_97240_low.las 3/26/2015 11:12 AM 1KB
BROG2_97240_vegetation.las 26/201511:12 AM 41,740 KB

File name BRO62_57240_ground las -
Flesoftype:  [Al Fles () »] [ Canedl |
- Options




Click done when the correct files have been selected.

Now an Import Terrain Model(s) dialog box will appear. (Shown Below)

- x @ Options
Terrain Models ~
b [¥]Ground Append to existing Terrain Model
Terrain Model to append to
Filter ~
Filter None El
Source File Units Unknown El
Feature Definition ~
Feature Definition ¥_Trangles El
Import Options Import Temain Only El
Geographical Coordinate Systems -~
Source None =)
Source Description
Source Units
Target None (]
Target Description
Target Units

Utilizing the settings depicted on the previous page (and described below) Import the data into the
design file.

e Terrain Models Section
o This section will be greyed out unless you are appending data to an already
existing model.
¢ Filter Section
o Filter
» Use the Tin function here to allow the user to select the Z tolerance.
o ZTolerance
» This function will filter out points in the terrain that do not add any
additional elevation features to the limit specified by the user.
o Reinsert Points
» This function can be left off for typical tin generation.
o Test Filter
» This allows the user to see how many points will not be used in the
creation of the tin (changed by the adjustment of the Z Tolerance).
o Source File Units
» All current CADD and Mapping Deliverables are in US Survey Feet.



e Feature Definition
o Feature Definition
* Depending on the deliverables the user can create several different layers
that use the ODOT naming and visualization standards. For a typical tin
use X_Trianlges. Then once imported the dialog box remains open to
import contours or additional deliverables.
o Import Options
» For a standard deliverable Import Both
o Include Spot Features
» This function can be left off since the features haven’t been generated yet.
e Geographical Coordinate Systems
o This section does not need filled out due to the .las files containing Meta Data
with this information (generally used for ASCII importing).

If not already done so please import the data

Creating a Complex Terrain Model

To create a complex Terrain Model, the user will need to either have the terrain models in the same dgn
or attached as a reference (see Terrain Model Creation).

Tasks ~ 0 X N
Tasks - | [
[ Civil Tools |'
Eﬂrﬁsrgtlﬁréﬂwrﬁ

Sy B 4,
& Analysis & Reporting
ﬂl General Geometry

»

v

£ Horizontal Geometry w
HB vertical Geometry w
-~

# Terrain Model

EVE 2 00 By By o
R AR E s g

Select the Complex Terrain Model Tool from under the Civil Tools = Terrain Model toolbar (boxed in
Red).



The Complex Terrain Model dialog box will appear.

Select Terrain Models
Select Terrain Models to Merge or Append

Process Order MName Merge/Append

_ FRA270-39.68_53359XAED1 [They

FRAZ70-39.68_53359XAED2 [ﬂppend

Current Action
7 Merge
@ Append

Temain Model Properties
Terrain Feature Definition

Feature Definition ¥_Trangles
MName EXGR

From Selection Set > [ Cancel H Finigh ]

From the left pane, select the files you wish to complex together. Then press Add.

Determine which file should be the primary and the appended file and select the Feature Definition
from the drop-down menus.

Press Finish to finalize the terrain.



TopoDOT

Importing LAS files

Step 1. Open Micro Station
Step.2 Select a 3D seed file.
Step 3. Click the TopoDOT button and select run TopoDOT

CANODOTSeed3d.dgn [3D - VB DGN] - MicroStation V8i (SELECTseries 3) Vs :

File Edit Eement Settings Tools Lhiities Cadig Workspace Window OQDOT Help | TopoDOT

1

After clicking the TopoDOT button this text window will appear:
p =

TopoDOT version B.8A.5.17
Copyright <(c>» 20815 Certainty 3ID. LLC. All Rights Reserved.

Connecting to license server...

Licenze Accepted

There iz a TopoDOT update availabhlet! Please click Check For Updates in the TopoD
0T Menu.

Don’t exit out of this just let it run.

Step 4. Next select the TopoDOT tab under the task bar
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Step 5. Select the Load Point Cloud From File tab
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From this tab select the LAS file that you want

Step 6. Choose the display mode that you want your LAS file to be in (Classification, intensity, colored
intensity etc.) This can be done using the View Settings tool located below.

w F;::—? — r-"'.i r-'l-"'.i i '

aresuTy  coasTeEs

- L)
i il

m

This is a Bridge LAS file that was scanned in Hamilton County on 275

Step 7. Turn off the layers you don’t need using the Layer Visibility tool



[0 - Unclassified
B 1 - Default
v/ 2 - Ground
3 - Low YVegetation
B £ - Medium Vegetation
5 - High Vegetation
& - Building
7 - Low Point
& - Model Keypoints
9 - Unknown
vl 10 - Single Targets
11 - First Targets
12 - Other Targets
B 13- Last Targets

» ALLON |

From this you can select the different class layers that you want to be turned on.

File Settings (Checking Units)

Click on TopoDOT tab and select File Settings



Help | TopoDOT | TopeDOT : @ v | [
Poirt Cloud r
Bl Display Settings
£ Miew Settings
. ?‘ Poirt Snap Mode
Q‘ ! File Settings | ﬁfvl

Reset Tool Settings

Beqister for C3d University
Get License Usage Report
Report Bug

Version Information
Check For Updates

Purpose

Used to set units and other settings for the variety of Point Cloud files that will be read into memory. NOTE:
Design file units can be different then point cloud file units!

e Point Cloud files that do NOT have their internal units defined will require the 'Units' feature of this tool to
be set correctly.

e If the point cloud files DO have their own internal units then the 'Units’ feature of this tool will not affect
the outcome of loading these files.

Files WITHOUT internal units | *.LAS, *.LAZ, *T3D, *.XYZ, *.ASCII, * TXT, *.PTS, etc.
Files WITH internal units *DOT, *.RXP, *.E57, *.FLS , *.POD, *.3DD, *.CL3/CLR, *.BIN, *.ZFS, etc.

e If a scaling issue happened it happened prior to the *.DOT creation when working with the 'Files
WITHOUT internal units'. In this case, you must revert to the original raw files and set the units correctly
before moving forward, select the proper units within this tool.



General | LAS Fies | RIEGL Files | DOT Files | General | LAS Files | RIEGL Files | DOT Files |

IInits: [Meters v] RGE Range: [D-255
[] Thin Incoming Data Mth Paint: RGE Export: [HGE
[E1 Thin Static Scans by Distance: 7] Classify by Flight Line

Data Maoise Thickness:
Limit Incoming Peints: | 25000000

HSaveHvAppl]r‘ ‘x{:am:ﬂ HSaveHvAplﬂ}" ‘xﬂanml

Fh | N | - Fh '_ll—

| General | LAS Files | RIEGL Files | DOT Files | | General | LAS Files | RIEGL Files | DOT Fies |

[ Pulse Deviation Limit: Load as One File

Tool Settings
Tab Tool Settings Effect

Some files do not contain unit information. This setting will allow you to

Units specify the units of those files. US Survey Feet, International Feet, Meters
Thin Incoming Enable to load partial amounts of each data file based on the 'Nth Point'
Data value.

General Nth Point Value for Thinning Incoming Data. Value of 2 means 50% of data will load,

3->33%, 4->25% and so on.... 10->10%

Thins out the over-saturated region around the system (proximity to the
Thin Static Scans | scanner origin) while maintaining points farther away. This will generally
by Distance reduce the point count for a static scan by 80-90%! <low, medium, strong>
for STATIC scans with an ORIGIN ONLY.



Data Noise
Thickness

Some tools will use this noise tolerance value for calculating the ground
elevations. Rule of Thumb: take a thin cross section (0.5'-1") on a hard
surface and measure the depth of noise you see (min to max) and then
use this value for your 'Data Noise Thickness'. For example, if a thin slice
of my road surface is 0.25' thick, then this value will be used because this
is my ideal flat surface value. Also, adjust for grassy areas as well because
they will be different thicknesses in most cases.

Limit Incoming
Points

Limits the total point loading capacity to the specified value. This is to cap
the memory used by loading in data so that the TopoDOT tools can still
function. The value entered will vary slightly between workstations.

LAS
Files

RGB Range

LAS files can contain RGB information within their internal format. Select
the correct range so the RGB information will be read correctly within
TopoDOT.

RGB Export

There are 3 options: RGB, Plane Deviation, Color Contour. See Export
Points on how to export points.

o If RGB is selected then current RGB values will be used during export.

e If Plane Deviation is selected then the current color scheme (defined
by ACS, min & max values) will be used to override RGB values during
export. See Plane Deviation Color Scheme to change color scheme
and see Display Settings to calibrate color-gradient to point elevations
in 'Distance From Plane' tab.

e If Color Contour is selected then RGB values will be overridden with
the current 'Colored Contour' settings. See 'Colored Contour
within Display Settings.

Classify by Flight
Line

When enabled, normal LAS file classifications will be replaced by the flight
line information. The point cloud file must have internal flight line
information for this to take effect.

RIEGL
Files

Pulse Deviation
Limit

When enabled, this may reduce LiDAR artifact points base on their internal
deviation values.

DOT
Files

Load As One File

When loading DOT files, if enabled, the data will appear as one single file
in the point cloud manager. If disabled, each individual file that was
previously used in creating the DOT will appear in the point cloud
manager.

Optimize
Exported DOT
Files for
Visualization

This will allow optimization during the manual export process. See Export
Points on how to export points. If you are looking to Optimize a set of DOT
files please see Optimize Files For Visualization



http://www.certainty3d.com/wiki/index.php?title=Export_Points
http://www.certainty3d.com/wiki/index.php?title=Export_Points
http://www.certainty3d.com/wiki/index.php?title=Plane_Deviation_Color_Scheme
http://www.certainty3d.com/wiki/index.php?title=Display_Settings
http://www.certainty3d.com/wiki/index.php?title=Display_Settings
http://www.certainty3d.com/wiki/index.php?title=Export_Points
http://www.certainty3d.com/wiki/index.php?title=Export_Points
http://www.certainty3d.com/wiki/index.php?title=Optimize_Files_For_Visualization

Load Aerials

Purpose

Allows user to reference files from the public database of aerial images such as GoogleSat and BingSat.
These aerials are imported into MicroStation™ and provide a rough estimate of project environment and
terrain. Aerial Images are most helpful when starting out projects with no CAD work or extraction, because
the images can be used as templates for setting up an extraction process. Also, a great alternative to not
having High Resolution Calibrated Aerial Images!

e There are a few options to choose when using TopoAerial images within MicroStation. Please see How
To's for details:

1. Temporarily transfer what is currently being displayed within the field of view (FAST)

2. Temporarily transfer detailed images of what is currently being fenced in (SPEED depends on
size of region being fenced)

3. Permanently save a fenced in region as *.jpg images for rastering, see HOW TO's below for
more details. You can either use the Pencil-Fence or the Red Fence (hold both alt and right
click).

RIS Mo Tie: st

ﬁ Coof-dinate System E:@
| Custom Definitions

Coordinate System

exas Dallas County: Nad83| v | Search

[ | Set/Save ‘
Description Texas Dallas County / Nad »
Projection Lambert Conformal Conic | |

First Standard Parallel 33d58

Second Standard Parallel 3242

Origin Longitude -98d30

Origin Latitude 31d40 =
False Easting 600000

False Northing 2000000

Scale Reduction No Value -

< 1 ] »

Window for selecting Coordinate System

TopoAerial window once the tool is launched

Tool Settings
Load Aerials

Tool Settings Effect

0 Select Select Project State Plane or UTM Zone
Coordinate System

chn & AUtO- | 7450m to Project area once coordinate system is chosen or Auto Zoom.
Zoom 7 i
' Import displayed (current zoom and area) Aerial Image into Microstation™
— Transfer view. This temporarily pulls the imagery into the design environment.



http://www.certainty3d.com/wiki/index.php?title=File:4_ImageProject_TopoAerial_globeicon.png
http://www.certainty3d.com/wiki/index.php?title=File:4_ImageProject_TopoAerial_importicon.png

=% Tile and Import (zoomed-in-images) the displayed Aerial Image into MicroStation.

" Transfer This will also work in relation to the 'Fence Project Area’ feature. This temporarily
Detailed Tiles pulls the imagery into the design environment.
I‘ﬂ Save Save a specific Aerial Image as .jpg with a sister file .jpgw (world file)

-

. Creates a fence around a region of interest. 'Transfer Detailed Tiles' will use this

E Fence Project o .
Area fence to bring in necessary zoomed-images.
® Remove Deletes the created fence if one exists.
Project Area
Jump to Type City, State, Zip to Manually move to an area of interest
Map Type Select source and type of Image/Map, such as 'GoogleSatelliteMap'

Note: Other details are described below in How To's

How To’s

To Transfer Aerial into Micro Station view

1. Activate Tool by clicking Icon. A "TopoAerial' window will appear.

2. Click 'Select Coordinate System' (option window appears) and chose a system corresponding to
project. 'Search' State Plane or UTM Zone.

3. Click 'Set/Save'

4. Now, click 'Zoom' to zoom into project area or simply scroll the mouse wheel to zoom in.

5. Isolate a Aerial region within the TopoAerial window, and click "Transfer'.

Note: Make sure there is CAD elements or LIDAR Data within the design file, such as '‘Mapped Scan Icons'
or a .las file, in-order for TopoAerial to locate project area (Image elevation will be placed at a set distance
below these elements/data to avoid covering project). Also, the project should be geo-referenced to use
these photos effectively. Image is flat, so use while in TopView only.

To Transfer Detailed-Tiled Aerial Images into Micro Station view

Activate by clicking the icon. This will prompt an 'Accept and Cancel' sub window.

Now draw a fence around the region of interest. Right-Click to add polygon vertex.

Once the fence is or desired results or completed, simply click ‘Accept'.

You are now ready to proceed with importing detailed images (which are tiled) from this region.
Select the 'Transfer Detailed Tiles' feature to import into MicroStation.

e Detailed-Tiled Images are going to be loaded within the MicroStation view and will be
indicated via a progress bar.

PN pE


http://www.certainty3d.com/wiki/index.php?title=File:TileTransfer_ICON.png
http://www.certainty3d.com/wiki/index.php?title=File:4_ImageProject_TopoAerial_saveicon.png

Jump To: orlando Map Type: GoogIeSatelhteMap

A

x Cancel ||~
B
= nght cllck to addla pol) gon vertex 3"?1 Y

Transfering Detailed-Tiled Aerial Images
Transferring Detailed-Tiled Aerial Images

To Utilize Street View

1. Select the Aerial region of interest.
2. Hold 'Ctrl' and 'right-click' on the selected Aerial region to obtain a Street view.
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Activating street view within TopoAerial



Jump To: I

(LI ECTET]

5632 International Drive, Orlando. Florida, United States
Address is approximate

Activating street view within TopoAerial

To Save Aerial Image for future Rastering into Micro Station

n

No okow

First, select or box-in region to be saved. Hold 'Alt' and hold 'right-click’, then drag to box in

region of interest. Red box will appear.

e An alternative method for selecting an area is to use a 'Fence' (pencil looking icon). This
method will ignore the specified tile-array within the tool and save based on a preset
determined tile size.

Now, click 'Save' Icon, to save this Image as a .jpg file. A corresponding sister-file will auto save

as a .jpgw file.

Click, Save. Export World File Settings - Window will appear.

Choose 'Save Location'

Choose 'World File Units'

Choose 'Zoom Level'. How detailed the images will appear.

Choose 'Tile Grid' (ONLY applies to the Alt-Rclick method and does not apply to the pencil-

fence method). How many images there will be total. So, a1 X1 =1 Image, 2 X 2 =4 Images, 3

X 2 =6 Images.

Aerial Image(s) have been saved as a .jpg with .jpgw sister-file(s).



Rl
(o=

o

aluB)

ma

@

e

ramdmnat:

~

SaiGiiike

s, |

vy
“&T0

Alternative method for selecting an area using pencil-fence




C:\PROCESSING (. __‘\Rerial_ jpg |[ ]

Raster Units: [I'u'leters

Zoom Level: 4

Tiles: [ 1] x [1]
[ |=) Export J ‘ X cancel

Window for choosing directory, units, zoom and amount of tiles

To Create a Custom Coordinate System

Activate Tool by clicking Icon. A 'Topo Aerial' window will appear.

Click 'Select Coordinate System' and then click on the 'Custom Definitions.'

Navigate through the Main and Advanced tabs and fill out all that apply.

Once done, click 'Save' which will store the defined coordinate system within an existing file.
e The file location C:\TopoDOT\MicroStation\nad\Custom.ini

5. Now, go back to 'Select Coordinate System' and chose the newly created coordinate system.

PN E

Main | Advanced
Description: [New Coordinate System

Projection: (7) Transverse Mercator

Transformation (Survey Feet)
Scale Factor: |1.000136506

X Offset: ’11—|DDDD'D'DDM
I ™
Y Offset: 0.0DDDDOODD TopoAerial o u

Order: | Translation, Scale -

[ Force Projd/wKT String ~ If any changes need to be made to this coordinate system, please locate
| | the 'C:ATopeDOT\MicroStation\nad\Custom.ini file.

@ Lambert Conformal Canic

st Standard Parallel: : ' El
2nd Standard Parallel : ' El
Central Meridian: |D 0000
Origin Longitude: ’ E El
Origin Latitude: ’ ' El
False Easting: _
False Northing: M
Equatorial Radius m
Eccentricity:

i se |

|'/.7.\'| Coordinate system saved as: Example Coordinate System
'

i

L
IMessage Displayed when 'Saved’

Main Tab Advanced Tab

Note: If you don't have the coordinate system or ellipsoid values then try locating it within MicroStation’s
library: Go To 'Tools->Geographic->Select Geographic Coordinate System.' Now click the 'From Library'
Icon and find the corresponding coordinate system information either by searching or selecting from the
Library Tree.



EPS5G:2323 - ED5S0 / TM33 for Turkey
EP5G:2324 - ED50 / TM42 for Turkey
EPS5G:2325 - EDS0 / TM45 for Turkey

Coordinate System

Name

=» Description

ERPB0-TK.TM27 - EDB0 / TM27 for Turkey

1 Cumrent Geographic Coordinate System
Name:
Description:

<Monex

EDBOTK.TM30 - EDSOTK / TM3D for Turkey
EDS0TK.TM33 - EDS0TK / TM33 for Turkey
EDS0TK.TM36 - EDSOTK / TM36 for Turkey
EDS0TK.TM33 - EDS0TK / TM33for Turkey
EDS0TK. TM42 - EDSOTK / TM42 for Turkey
EDB0TK. TM45 - EDBOTK / TM45 for Turkey
EDS0TK-UTM35 - EDSOTK Based UTM, Zone
EDB0TK-UTM36 - EDSOTK Based UTM, Zone
EDS0TK-UTM37 - EDS0TK Based UTM, Zone
EDS0TK-UTM38 - EDSOTK Based UTM, Zone

Z4-TK TM 54 14 e
S84-TK.TM30 - WGE584 / TM30 for Turke
L7 N B R

0 - 04 Wz3tor [urkce

=»Projection

Source

Units
= Central Meridian
= Origin Latitu
= Scale Reduction
= False Easting
=»Fzlse Northing
Quadrant
Minimum Longitude

Minimum Latitude
Maximum Latitude

Maximum Longitude

WG584-TK. TM30

WGS584 / TM30 for Turkey

Transverse Mercator

Derived from ERP50-TK. TM30

Meter
30°00°00.0000"E
00°00"00.0000"N
1

500000

0

Positive Xand Y
28°30°00.0000"E
31°30°00.0000"E
36°03'00.0000"N
42°06°00.0000"N

4

Use the resulting values
to 'Define Coordinate System’
within TopoAerial.

Datum

Name
Description
Source

Conversion Methed

WG584

World Geodetic System of 1984
US Defense Mapping Agency. TR-8350_2-B. December 1987
WGS84 - no shift required

Ellipsoid

WGES584-TK.TM36 - WGESE4 / TM36 for Turkei
WGSE4-TK.TM33 - WE524 / TM35 for Turker

Polar Radius

WESE4-TK.TM42 - WGS584 / TM42Z for Turke

coentricity
Source

WGESB4-TK TM45 - WGES84 / TM45 for Turke,

WGSB4-TK-UTM35 - Same as UTMB4-35N. W
=7 WGESB4-TK-UTM36 - Same as UTMB4-36N. W
--42f WGS84-TK-UTMIT - Same as UTMB4-37N. W -
3

WwGs84

World Geodetic System of 1984, GEM 10C

6378137
6356752.3142

0.081819190928506743
US Defense Mapping Agency, TR-8350_2-B, December 1987

Searching for a Geographic Coordinate System within MicroStation

To Raster a Saved Aerial Image into Micro Station

1. You must have a saved Aerial Image and World File in-order to accomplish this. See above 'How To'
for this.

2. Locate image(s) using ‘Raster Manager".

e Please Search 'Attach Raster' using MicroStation's Help Content. Help/Contents/Search/raster
attach. Then search for saved Image file.

To Remove Aerials from working view

1. See Remove Aerials for removing temporarily transferred aerials, not rastered aerials.



http://www.certainty3d.com/wiki/index.php?title=Remove_Aerials

Bridge Clearance Tool

Purpose

Used to measure Bridge Clearances from features such as I-Beams or other features (Powerline clearance
to road for example, within the How To's below).

Note: If working in the CONNECT environment and dimensional elements are appearing properly please
note that your dimensional styles need to be modified from default if not already set up. Step 1) Go to
Dimension Styles and create a style then name (example: 'dimensions'). Step 2) under the Text tab make
sure 'Font, Height, Width' are set appropriately. Might have to disable ‘Font'.

#) Bridge Clearance — O x

'h_\ Define Path ¥ AcceptResulis
Sample Options Plat Options

Yehicle Tolerance: Bridge Sample ‘width: (@) Calculate &ll Beams Clearance [] Plot Text
Road Sample Interval: Beam Height: () Calculate Lowest Beam Clearance

() Calculate Lowest Clearance

TELIETIE L SEICED I () Mo Automatic Calculations

Foad Sample Length: Grouping Window: 0.15 Orient View: |2 .

Options Default with No Measurements Yet


http://www.certainty3d.com/wiki/index.php?title=File:BridgeClearance.PNG

“ Bridge Clearance [ = ﬁ]

+ Define Path ‘

Sample Cptions Plot Options

Wehicle Tolerance: Bridge Sample Width: @ Calculate Al Beams Clearance Plot Text
Road Sample Interval: Beam Height: Calculate Lowest Clearance
Road Sample Width: Beam Spacing: No Automatic Calculations

Road Sample Length: Grouping Window: 015 Onent View: |2 -

Options Default with Measuremenis

Tool Settings

Sample Options

o Tool Settings Effect

Enter the height of any vehicles that may be included with the sampling
Vehicle Tolerance process. If this is set too high, as to interfere with actual bridge data,
then there will be no data to display within the preview.

Interval of sampling for the ground elevation. The intervals will take

Road Sample Interval place along the direction defined.

Sample | Road Sample Width Width of data to sample for ground elevation (Perpendicular to path
Options direction)
Road Sample Length | Length of data to sample for ground elevation (Parallel to path direction)
Bridge Sample Width | Enter the width of the Flange of interest

Beam Height Enter the height of the beams of interest

Beam Spacing Enter the spacing of the beams of interest



Grouping Window

Boundary(width) dimensions for sampling data, which calculates the low
and high points of bridge profile

Define Path

Activates the placement of path for sampling process to take place

Accept Results

Accepts all measured values within the preview window

Calculate All Beam
Clearances

Finds all available beams and places measured values.

Calculate Lowest
Clearance

Finds only the lowest clearance beam and places a measured value.

No Automatic

Places no measured values. User will place dimensional values

Plot Calculations manually.
Options ) ) ) ) )
View used for the orientation of the dimension elements (related to 'Plot
Orient View Text"). This value will most likely be at the bottom of the dimensional
element.
Enables auxiliary measured values to be placed at the base of each
Plot Text dimensional element. This Text will be oriented according to the 'Orient
View' setting.
)
— Clear Clearance | Removes all clearance measurements
Measurements
"R
emove Road Removes selected road vertex
vertex
How To’s

To Measure Bridge Clearances

1.

2.

Isolate or locate beam data and have multiple perspective views ready for reference. Mainly a
top view perspective and cross section Cross-section by Points
Activate tool by clicking icon, window will appear:
e Proceed to entering the specific settings within the ‘Sample Options'
1. Use MicroStation’s measuring tool to quickly measure profiled features of the

bridge.

2. This step may not be necessary, but it will produce the best results for unique
bridge profiles.

e Select which results to be plotted in 'Plot Options'

1. See Tool Settings for details

Now click, 'Define Path'.

e Within top view, define the path across (perpendicular) the bridge. To define, click once on
one side of the bridge and then click a second time on the other side of the bridge. Make
sure to include the entire width of bridge, because these two clicks define the boundary of
sampling (which is basically a cross section)

e This path does not have to be perpendicular. For instance, if a road passes diagonally
underneath the bridge, then a path parallel to the road may be defined. But, the larger the
deviation from perpendicular, the more tilt there will be in the bridge profile; therefore, 'No


http://www.certainty3d.com/wiki/index.php?title=Cross-section_by_Points
http://www.certainty3d.com/wiki/index.php?title=File:ClearClearanceMeasurements.PNG
http://www.certainty3d.com/wiki/index.php?title=File:RemoveRoadVertex.PNG

Automatic Calculations' may have to be chosen for the 'Plot Options'. This way, user can
manually input measurements based on what he/she sees in the preview window.
4. Bridge profile will appear within the tool preview window. 'Right-Click’ to pan, 'Scroll/Center-
Click’ top of measurement to delete, ‘Left-Click’ to add measurements.
e The Lowest value measured will be bold and highlighted a 'mint-green’ color. Reference
only, and is visible only in preview
e Examine analysis and make sure the results are satisfactory. Add (for features missed or for
non-beam features such as pipe) or Delete (for duplicates or unwanted features) as
necessary.
Once QA/QC has been carried out, click '‘Accept Results'.
6. The dimensional elements and measured values in the preview have now been placed within
the design file.
7. To repeat, define new path and follow steps.

o

Note: When Results are accepted, the lowest calculated value will automatically be placed onto your
‘clipboard' so you can proceed to pasting this value within another document: .csv, .txt, .doc, etc.

& View1 - Top, Default o @ | 52| | = view2, Defauit (=0 EoR(|
]z s - [[A]R S HIEH 90|90 EG

B-Id#-|ARSREHY O WEB|H 73R
| 'lsometric View' |
f‘ M‘w T ¥

[ Second: Define Path by two
'Left-Clicks' in Top Vien ‘L

Click one

=~
< Results ——>

Third: Prev appear in tool. Add or Delete.

Final: Click
'‘Accept Results' j’

' Accept Resulls
Sample Optians Plot Options

Vehicle Tolerance: Eridge Sample Width: 8! Calculate All Beams Clearance Plot Text
Road Sample Interval. Beam Height Calculate Lowest Clearance
Fioad Sampls Width o No Autematic Calculations

Road Sample Length Grouping Window: | 015 | OrientView: [2 -

First: Click 'Define Path'——> . Define Path |

Click two

1]2]3]2|5]s7]8| : =t [0.0000 £ [0.0000°

Steps for using Bridge Clearance
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Results of the Bridge Clearance tool

Note: This tool is not limited to Beams on Bridges, so please feel free to apply this tool to other applications
such as Power Lines, Overhead Signs, Cranes, Pipes on Bridges, etc.

To measure Wire to Road Clearances

1. Follow steps as above, but instead choose 'No Automatic Calculations' for 'Plot Options'
¢ Now add measurements to preview (which will be cross section or profile of wires)
2. Click 'Accept Results' to place measurements



s View1 - Top, Default

Wire & Road
Directions

. Define Path

Sample Options

Road Sample Interval:
e Road Sample Width:

TopV| ew' Road Sample Length:

% AcceptResulis

=] Plot Text

Plot Options
Calculate All Beams Clearance

Vehicle Tolerance: Bridge Sample Width

Beam Height:

Beam Spacing: @ No Automatic Calculations

0.5 | Orient View

Calculate Lowest Clearance

Grouping \Window:

Applying Bridge Clearance tool to overhead power lines over a diagonal section of road



Wall Monitor

Purpose

Allows the user to monitor multiple wall surface data sets for deviation and settlement. There are two ways
to use this tool: one is to use a guideline that the user traces out on an ordinary flat wall (this method is
limited to lateral movement only) and two is to use a CSV Stationing file on a paneled-retaining wall (this
method will allow for lateral and settlement calculations).

For a detailed explanation of what this tool is capable of on a paneled retaining wall please see our tech-

note here.

£ Wall Moniterin X
9

Stationing  Lateral Movement  Settlement  Options
Data Options Panel Stationing

Data Thickness: Start

H
® @ @

‘Width: 100.0 Stop:
L [500] n

Wall Angle:

Intervals:

(HE

Orient: | Left
Path Selected: X | GetSelected

Information
Current Panel:  N\A
Current Distance: N\A

= Previous New wp

Main Tab

OPTIONS TAB

#) Wall Monitoring
Stationing  Lateral Movement  Settlement  Options
General levels Excel Labels
Update View: |2 -
[[] Clip Datz zt Each Panel
Process Data Files Individually
Height Limit
Noise Tolerance:

[] Use Less Smoathing
[[] Load Data Dynamically

Scan Distance

Information
Current Panel:  NWA
Current Distance: NWA

&= previoss New =

Options General Tab

Tool Settings
All Tabs- At bottom of tool

#) Wall Monitoring

Stationing  Lateral Movement  Settlement  Options

Options Plotting
Data Interval [] Base Line Surface Shats

[ Tolerance: 003 Connect Base Line Shets

[] Flzt Baseline Comparison Surface Shots

[] Connect Comparison Shots

i vison
Cther
005
Max Deviation [] Creste Spreadshest

Process Current Panel Process All Panels

Information
Current Panel:  N\A
Current Distance: NA

= Previoss New =

Lateral Movement Tab

#2 Wall Monitaring
Stationing  Lateral Movement  Setflement  Options

General Levels  Excel Labels

‘wiall Shots:

|5urfa:e Shots %f ~ ‘
‘izl Line:

[Surtace Line ¢ ]

#) Wall Menitorin X
9

Stationing  Lateral Movement  Settlement  Options

Options Plot Options
Min Deviation: | 005 ] Plot Panel Text
Other

Max Devistion: | 0.05

Tolerance:

Sensitivity: | 075

Jaint Search Window:

[[] Create Spreadshest

Process Current Panel Process All Panels

Information
Current Panel:  N\&
Current Distance: N\&

&= previos New wp

Sefflement Tab

#) Wall Monitoring b
Stationing  Lateral Movement  Settlement  Options

General Levels Excel Labels
Lateral Movement

Graph X-Auis: [Offset From Guide Line |

Graph Y-Auis: [Bevation |

Settlement Results:
[settiement ]

Information
Current Panel:  N&
Current Distance: N

&= Previos

Options Level Tab

Graph X-Auis: [Panel |

Graph Y-Aiis: [Settlement |

Information
Current Panel:  NA
Current Distance: MA

= previoss New =y

Options Labels Tab

Tool
Settings Effect
. Displays the Current Panel/Position/Station and the Current Distance. Note: Tool starts
Information ; L . - ;
everything from the beginning of the line unless specified otherwise.
Previous Move down along the guide line. This tool is for navigation purposes only and will not
Panel process.
Next Panel Move up along the guide line. This tool is for navigation purposes only and will not process.



http://www.certainty3d.com/pdf/technotes/StructuralWallMonitoring.pdf

Data Tab
Tool Effect
Settings
Enter the thickness (in working units) of the desired slice to take at each
step/panel/position for sampling purposes. The thickness depends on the
density of the scan, surface conditions, flatness. What would constitute a higher
Data
Thickness valued sample? -> sparse scan data, deeply ruffled/grooved/textured surface,
relatively flat surface when sampling. What would constitute a lower valued
sample? -> very dense data, smooth surface texture with no grooving depth,
relative surface is not flat and more organic in nature (rock face for example).
Search parameters on how far to search for data from the guideline. This will
Data Width look (perpendicularly from guide line) left and right a specified distance. This
Options will override values within the L/R text boxes.
L /R Modify left and right distance from the guideline to process. For example, this
B allows you to look 5 units left and 10 units right.
Reference angle to use for processing wall information. If the wall has a 45-
Wall Angle | degree tilt (throughout) from vertical then match this, if the wall varies +/-20
vertical then keep reference angle at 90 degrees.
. Orientation along guideline. This should be pointing towards the surface from
Orient .
the scanned side.
. Turns off all point cloud data except for current station. This is essentially going
Clip Data . S
to clip the data as tool moves up and down guideline.
A user defined position along the path on where to start. This will apply when
Path Start \ \ . .
a Auto' extraction is used.
Stationing
Ste Station interval along guideline (in working units). Tool will move down the
P guideline at this interval.
Position A user defined or 'Current' position/location along guideline.
Select path for tool to follow and click 'Get Selected' to Activate. Note:
Path X . : .
Selected compatlble elements include a poly lines, arcs, circles, blocks/shapes and
bsplines.
Lateral
Tool Effect
Settings
Data Interval Enter spacing in which points are placed in the profile/cross-section (working
units). These will be the points going up the wall.
Options
Tolerance This relates to the deviations defined. If enabled, measured deviations within
this tolerance will be colored white.




Measurements will be from a plumb/vertical baseline (the guideline will be
your 'zero' and a vertical baseline will originate from here at each

Flat Baseline panel/position). This feature should be used if you want to compare a single
wall file to a vertical plumb line. Disable this feature when comparing two files
of the same wall.

Min / Max Minimum/Maximum Deviation used for coloring shots. Everything outside of

Deviation the min/max deviation will be assigned the min/max color.

Base Line

Surface Shots

Check to enable shots to be plotted on the base line data.

Connect Base

Check to enable profile line to be plotted on the base line data.

Line Shots
Plotting ;
gﬁ?;ﬂ';ﬂ;ts Check to enable shots to be plotted on the comparison data.
Connect
Comparison Check to enable profile line to be plotted on the comparison data.
Shots
Create excel spreadsheet for the entirety of the wall and each individual
Create cross section. There will be a main sheet that displays all deviation points to
Other Spreadsheet the user as if he/she were looking at the wall (wall is essentially flattened out
P so curving walls will now seem flat). The following sheets will show each
cross section with graphical and indexed deviation values.
Process "
Current Panel Processes only the current position.
Process All Processes the entire length of the selected guide line at the specified
Panels stepping intervals.
Settlement
Tool Effect
Settings
Min / Max Deviation used for coloring any resulting arrows and deviation text. Everything
Deviation outside of the min/max deviation will be assigned the min/max color.
This relates to the deviations defined. If enabled, measured deviations within
Tolerance this tolerance will not be identified but you will still get a flat deviation element
(green).
Options Sensitivit Sensitivity level for locating panel joints. Higher values will make the tool less
y sensitive to noise. Default value is 0.75 (design file in feet).
This distance value defines how far to search for other comparison joints, if 2
Joint Search joints are found and each are from a different file than they'll be coupled for
Window comparison. The value here should be larger than the observed movement
but smaller than the span in between repeat joints (on the same
wall/data). NOTE: For a paneled wall the distance in between the horizontal




joints are usually around 5 feet while the comparison movement is only 0.02-
0.06 feet.
Plot Plot Panel This will assign panel text to each position/station. Text will be View
Options | Text Independent'.
Create excel spreadsheet for the entirety of the wall and each individual cross
Create section. There will be a main sheet that displays all deviation points to the
Other user as if he/she were looking at the wall (wall is essentially flattened out so
Spreadsheet . . ; ;
curving walls will now seem flat). The following sheets will show each cross
section with graphical and indexed deviation values.
Process i o
Current Panel Process the current position only. Make sure the data is displayed.
Process All Process the entire length of the selected guide line at the specified stepping
Panels intervals. Make sure the data is displayed.
Levels Tab
Tool
Settings Effect
Designate level for this feature extracted. The file name of the corresponding point
Wall cloud will also be included within the level name. For example, if the point cloud file
Levels Shots name was 'PT123' and the designated level was 'Surface Shots' then the resulting
level produced will be 'Surface Shots PT123'.
Wall Line | Designate level for this feature extracted. File name applies just similarly, see above.
Options
Tool Effect
Settings
. View used to display the current cross section. This will update as we move
Update View o
along the guideline.
Clip Data at Clip or Turn-off point cloud data except for the current station/position/panel
Each Panel '
Process Data
General | Files Process each data set separately.
Individually
Max height based off the reference wall, ‘plane’, to consider points as noise
and ignore. For example, if there is vegetation next to the wall and the
Height Limit guideline is within 1' of the wall data, then we can specify a value of 2' for a
height limit to help filter out noise. Remember that this value is normal to the
to the wall angle you specify.




Relative to the amount of noise in the data. Higher tolerance number
Noise corresponds to higher level of noise. This should be the depth of the
Tolerance 'fuzz/noise' normal to the wall sample. To measure this, take a thin (usually
the size of your 'data thickness' or sample) cross section and measure.

Less Smoothing of the result but higher chance to pick up noise. If the wall

gr?qeotterﬁfm varies such as a rock face would then 'enable’ this, but if the wall is relatively
9 flat and consistent then 'disable’.

Load Data Loads necessary data, samples, and then Unloads that data at every cross
Dynamically section.

Determines the relevance of scan data based on the specified distance from

Scan Distance the scan position to the cross section.

Wall Shots level for Wall Shots

Wall Line level for wall line
Levels

Settlement level for Settlement Results

Results

Lateral . . . .
Excel Movement The string specified here will be used for labeling purposes
Labels

Settlement The string specified here will be used for labeling purposes

Pre - How To’s

There are two types of movement that can be monitored within this tool: Lateral and Settlement. Lateral
movement is within a horizontal reference frame. Settlement is a vertical shift in a wall. Please see our tech-
note which further explains this notion, tech-note

Note: A stationing file (CSV format) is NO LONGER supported to replace a physical CAD guideline. The
'Path Selected' (guideline) tells the tool where the wall(s) or panel(s) is in horizontal space and the ‘Wall
Angle & Orient' tells how it is tilted and oriented to the guideline.

Lateral Movement Cases:

1. Movement relative to a Flat Baseline (one file or one wall)
e Here we will be comparing one vertical wall to a flat baseline so that the reference point for
monitoring will always be against a vertical surface.
2. Movement relative to a Flat Baseline (two or more files/walls)
¢ Here we will be comparing two or more vertical walls to a flat baseline so that reference points
for monitoring will always be against a vertical surface. Typically, you'd have 'Process Data Files
Individually' ENABLED.
3. Movement relative to another Point Cloud (two or more files/walls)
e Here we will be comparing two vertical walls relative to themselves. Typically, you'd have
'Process Data Files Individually' ENABLED.

Settlement Movement Case:
1. Settlement relative to another Point Cloud (two or more files/walls)
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e Here we will be comparing two walls relative to themselves so that the shift can be tracked.

How To’s

Method 1:

Extracting a Grid of Colorized Spots on an Ordinary Wall Surface (Gradient based on deviation)

1. Load the first set of data, which will be the 'Base Surface'. Then load the second set of data,
which will be the 'Comparison Surface'. See Point Cloud Manager for file order and color
¢ Now isolate a region of the surface to process. Go ahead and place a fence around the

section of wall and crop the data outside the fence for further isolation. See Crop Points
Outside Fence.
e The preferred mode of display would be 'Individual Scans'. See Display Settings for details.
e Also, itis possible to crop each data set individually and then export as a .las or .dot point
cloud file. These newly created files can now be loaded and processed. Order of loading
still matters, see above.

2. Now, place a guide-line down the center of the surface data (this should be done in Top-View
and at an elevation close to the data). The guide-line should be flat, and only change
horizontally to follow surface. This will ensure a tight fitted guide-line for the tool to follow
e Also, a fence can be fitted to this guide-line to help crop out data beyond the wall surface.

See Fence Along Element and Crop Points Outside Fence. This would take the place of
fencing and cropping earlier, but make sure the guide-line is also a good center line

3. Open the Wall Monitor tool by clicking the icon. Tool interface will appear
e Select or Highlight Guide-Line and then Click, Move Up or Down to activate the positioning

of the ACS. This will be like the Road Extraction tool.
e Enable '‘Comparison Surface Shots'. Recommended because this will be the surface that
has deviated from the base surface
e Make sure to also Enable 'Process Data Files Individually' within the Advanced Tab.
e Disable 'Clip Data, Base Line Surface Shots, Connect Base Line Shots, Connect
Comparison Shots'. Optional
e If necessary, adjust Data Options: 'Width, Wall Angle, Data Interval, Step, Etc.". Optional
¢ The Wall Angle will appear as a magenta-colored line and should be lined up with the
surface data within the cross section view or slice. 90degree value will be straight down
or at 6 o'clock.

4. With the guide-line highlighted, click 'Process Entire Guide Line'. This will automatically run
along the path and process the entire surface data.

5. Toinspect, click 'Move Up' or 'Move Down' and examine each profile within the 'Update View'
(usually view 2).

6. Once done, the tool will have placed a grid-like pattern of surface shots or Point Elements.

e These Point Elements will be colorized based on the deviation value. Red (Max Deviation),
Green (Neutral Deviation), Blue (Min Deviation). This way, there will be a color gradient to
visualize and spot any areas that have deviated the most.

Note: If the Surface Shots or Point Elements are appearing as White, either the point falls outside of the
deviation values or the point is no good (possible data noise could pull a point away from the surface to
create a false deviation value).

Note: Make sure that when loading data, the order of this data is known, because the first point cloud file will
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be the 'base surface' while all other files proceeding, will be the ‘comparison surface(s)'. See Point Cloud
Manager to view order and color of data files. Technically, three surfaces can be loaded, with one being the
base and two being the comparison surfaces.

Note: If you decide to combine different days of a cleaned wall within a DOT format, then make sure to
Disable 'Load As One File' within the DOT Files tab of the File Settings feature.
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Creating a Guideline in the Direction of the surfaces

™ View1 - Top, Default
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Wall surfaces have been cleaned up
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Data | CSV Stationing | Lateral | Settlement | Levels

Labels | Advanced

Data Options Path Stationing

Data Thickness: [20

Clip Data

it [£0.0 | Start: [1.00

Step.

2nd: 'Click’
Previous or

Viall Angle: [89 Position: 262 Next Panel

Orient. [Left -

H Previous Panel |

Wall Monitor(sf

Data | CSV Stationing | Lateral | Settlement | Levels
Plot Options

Base Line Surface Shots Min Deviatien:
Connect Base Line Shals Max Devistion:

Comparison Surface Shts  Data Interval:

Connect Comparison Shots Tolerance:

‘ Process Current Panel |

‘ Previous Panel |

to Position
Slice.

Next Panel

Labels | Advanced

Flat Baseline

005

‘ Process All Panels ‘

Next Panel

Or use a 'Flat Baseline'
thin Lateral Tab.

Using the tool interfa




w0 View 1, Default

Results:
'‘Comparison Surface
Shots' have been
placed with a
gradient coloring.

EACEMEERE R L ==

W View 2, Default

E - @ -

¥% Wall Monitor(sf)

Dtz CSV Stationing | Latersl | Settlement | Levels | Labels | Advanced
Data Options Path Stationing

Data Thickness: Clip Data

:
\hdth: [20.0 Start: [0.00
: R:

Step:

Pesition

wiall Angle:

Orient: |Left -

Previous Panel ‘

Data_| CSV Statioring | L=ieral || Settiement | Levels | Labels | Advanced
Plot Options
Base Line Surface Shots Min Deviation Flat Baseline
Connect Base Line Shots
Comparison Surface Shots

Connect Comparison Shats

Process Current Panel ‘ ‘ Process All Panels |

Previous Panel ‘ ‘ Next Panel

ESRRTRSTY

Resulting Surface Shots
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Results:

Showing regions of Lower regions of
higher deviation on deviation on the
the left hand side. right hand side.

Results: Showing areas of high (red) and low (green) deviation

Method 2:

Extracting Lateral and Settlement movement using CSV Stationing file for Panel-Retaining Walls

1. Contact office for setting up this tool. (407) 248-0160


http://www.certainty3d.com/wiki/index.php?title=File:Wall_Monitor_4aa.png
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Beams

Purpose

Used to create beams based on specified dimensions that have been measured.

Window of tool Options


http://www.certainty3d.com/wiki/index.php?title=File:Beam_Creation_Options.png

Beam height

Flange width »I

/

Web thickness

-—

Flange thickness



http://www.certainty3d.com/wiki/index.php?title=File:Beam_Creation_Options_extra.png

Image of dimensions

Tool Settings

Tool Settings Effect ‘

'd' Beam Height ‘

'f Flange Thickness ‘

b’ Flange Width ‘

W' Web Thickness ‘

Place Place the specified beam as a CAD Element ‘
How To’s

To Create Beams based on measured Dimensions

1. Isolate or locate beam data and have multiple perspective views ready for reference.

2. From 'top view' take a cross section down a visible edge (usually the web face) of the I-Beam,
see Cross-section by Points.

3. From the ‘cross section view', draw a path down the I-Beam (a profile will follow this path later).

4. Now establish another cross section along the newly drawn path (such that a profile is best visible in
the data).

5. Measure the dimensions of the I-Beam (within the 'profile' cross section) using MicroStation’s
‘Measure Distance' feature. See Help/Contents/Search(tab)/'type measure distance'.
Activate |-Beam tool by clicking icon. Record measured values in spaces provided.
7. Click 'Place' to place a CAD profile within the 'profile’ cross section. Place Profile.
e To extrude profile, use MicroStation’s 'Solid by Extrusion Along'.
e Check 'Keep Path' and 'Keep Profile'. First select path, then select profile, and left-click to
accept.
e The profile has been extruded along the path
8. Use this profile for other beams or restart process for new ones.

o


http://www.certainty3d.com/wiki/index.php?title=Cross-section_by_Points
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0 View1 - Top, Default = @ |5 | | w View2, Default [Displayset] = e
q 9 [ ~ARQRHOY VNEE|HTRE

Then: Trace I-Beam feature to create path

Window for setting up cross section and path
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w View 1, Default

Measurements

Preview

Left-Click

Second: Click 'Place’ to activate tool, then left-click to

best fit
placement place the |-Beam profile (within this cross section view)

Method: |Between Poirts x|
About: [AccuDaw Z x|
First: Measure dimensions of
the I-Beam data and then enter _ Jls b
those values into the spaces L | AR
Total: | 0.1155f 0.1155sf

provided in 'Beam Creation’
X Y

Start Point: | -0.1155sf || -0.0000f
End Point: | 0.0000sf || 0.0000sf
Defta: | 0.1155sf || 0.0000sf

Window for sefting up an 1-Beam profile.




©

w View 1, Default
EHrad- A QRIMBESI VWL

Activate tool, then select |-Beam
path, then select path. Click to
accept extrusion along path.

¥

Alignment: [Normal |
Scale: | 1.0000
Spin: | 0.0000

Lock Profile Rotation

Circular ns

Allow Seff-Intersection
V| Keep Path
V| Keep Profile

Measurements
di| 33

Preview

Window for setting up an extrusion of the profile along the path




» View1, Default ===

1]

B-Ow-ARQRBHYI WG| HVIE
nﬂeamCreat'lon | Py |1
— Measurements —
f d[ 3.3
|| =g

— Preview

(@ Change View Display Style | = = |

Display Style: [Monochrome - K

‘Window showing results of the extrusion.

Note: Before placing a profile in the ‘cross section view', make sure to measure within this view beforehand
(in-order to activate the view for placement). If the profile does now match data (such as, rotation or size),
the CAD element can be modified by dragging/moving nodes/rotate. Also, I-Beam paths may need to be
adjusted by adding more nodes (to fit any deflection/curvature).



Break-Line Extraction

Purpose

The Break-line Extraction tool improves the accuracy of placing curbs & other break-lines based on a user
determined profile. This tool will follow a user defined path to display an enlarged cross section of the
feature to identify its shape, detail, and complexity. The blown-up section width is defined by the user. For
the tool to be applied in sections larger or smaller than a curb. The user defined path can be as intricate as
necessary; this tool is not restricted by the use of curves or splines.

#) Break-line Extraction - ] X #) Break-line Extraction - O X

Start Start

Accept
Skip

=
Flag Flag
=N ]
Undo  J<7SetPosition < > | #FlipTemplate| |gg Load Image Look Ahead Undo | | J27Set Position < > | #FlipTemplate g Load Image Lock Ahead
Template | Options Template Options
Color Level Adjust | (X, Y) Commands | Save/Load Data Misc Display Options
Red Flow Line - (0, 0) Move Template Save Step: Clip Data Paint Cloud Displzy Mode:
e Top of Curh -0 @iz 0408 = =i Data Thickness: Plat Points Nomal -
Blue Back of Curb ~| O |(0.498, 0.43) Set || Clear Dimensions [ Connect Lines [] Sync View: 1
Cyan Edge of Pavement - O |0, 0) Set Clear Extract Height Connect White Points Auto Picture in View: |2
Orange Break Line - O |0 0 Set || Clear Left: Dynamic Path [ Camera:
Magenia  |Brek Line 2 -0 o0 St |G Right Flatien Preview Break lines
White Break Line 3 -l O [ Add Del [ Lead Date Dynamically Step To Vertices
Interface & Template Tab Interface & Options Tab
6 Break-line Extraction Position Preview X

Preview Length: Preview Thickness: Freview Offzet:

Tool Settings

Break Line Extraction Interface

Tool
Settings Effect
Sets the currently selected element as a guide line for breakline extraction.
Interface | Start This will also reset to a new series of extraction if you are currently mid

extraction.



Accepts and plots the current position and placement of the Template Points.
After 2 'Accepts' you should see poly lines form.
Accept
Hotkey (Enter)
Skip the current position on the guideline.
Skip Hotkey ()
Flags the current position on the guideline.
Flag Hotkey (;)
Undo Undo any previously accepted Template Points.
. Allows you to move to a new position on the guide line. Simply activate feature
Set Position . o
and snap to any location along your guide line.
Position Make micro-adjustments for the positioning of the tool along its path/guide-line.
Slider Click arrows for 1 unit intervals or click slider itself for x>1 unit intervals.
Flip Template | Flips/mirrors the Template Points about a vertical line.
Load Image | Automatically load the closest image to the working area.
Enable this to display your Position Preview which is a cross section view
parallel to your guide line. This can be used to help identify where curbs
Look Ahead |terminate or transition into ramps/driveways. Note: If the guideline is on the
face of the curb and offset is 0' and thickness is 0.5' then you'll have a good
view at the face of curb to better identify transitions.
Zoom in the preview window.
Zoom In
“= Zoom Zoom out the preview window.
Out
0 o
Zoom Reset the preview window.
Reset
af . : : .
Increase | Increase grid blocks in the preview window.
Grid Block
Decrease Decrease grid blocks in the preview window.
Grid Block
Reset Reset any anchors created between template items. This essentially drops all
the anchors set
Anchors




+
Used to Increase or Decrease the vertical scaling of the data within the
Vertical | Preview. Use to help identify faint breaks

Scale

9~
: - Cursor display type (Normal or Full View).
Cursor
Toolbox

Template Tab

Tool Settings

Effect

Color Color of template item when created in design file.
Level Level of template item when created in design file.
Adjust Automatically drop/shift template item vertically to the data

Move Template

Move the template as one object.

Template | Set Place template item within preview window
Clear Remove template item from preview window
Save Save current template as a .rcf file
Load Load a previously saved template (.rcf file)
Extract Copy a template from within the design file
Options Tab
o Tool Settings Effect
Step Stepping distance to move to the next position along guide line.
Da_ta Thickness of point cloud data to process at each position
Thickness ’
. Elevation distance of data from the guide line to display in the preview
Height ind
Data window.
Left Left distance of data from the guide line to display in the preview window.
Right Right distance of data from the guide line to display in the preview window.
Load Data Loads relevant data inside the cross section and unloads any un-relevant
Dynamically data. This is generally used where data has yet to be loaded on a feature.
Clip Data Clip point cloud data at each position.
Misc.
Plot Points Place point elements at break points.




Connect Lines

Connect break points with a linear element.

Connect White
Points

Connect white points.

Dynamic Path

Continue a path after the end of the guideline.

Temporarily flattens the guideline so that 'up' in the cross-section preview is
perfectly vertical. No matter the tilt of the guideline, this will show you a

Flatten o . AN
plumb plane. This is not always necessary because an ideal preview is one
that is perpendicular to that of the features profile.

Step to Cross sections will automatically stop at every vertex

Vertices
If enable, the current cross section will be centered in the view specified.

Sync View This will essentially follow the ACS as it travels down the Guide Line. There

is now an option to SYNC ALL views within the drop down, which is usually
done when there is no calibrated imagery.

Auto Picture in
View

Automatically load the closest image to the current working area

Camera When checked, will use only the selected camera for image loading.
Bes.t Fit Ang!e . .. | Error Tolerance allowed when using the 'Auto/Auto-Fit' feature.
Options Deviation Limit
Preview When checked, enables live preview of template placement. Disabling
Display improves tool performance.
Options ; ; ; ‘e
Display Mode Drop down menu for the different display modes available. This will change

the display mode within the Tool Preview ONLY!

Note: Once a template point has been 'Set' it is now possible to manually enter custom (x,y) coordinates for
that point. If the point is not anchored to another then the relative (0,0) position will be the Red Point. The
(0,0) position for an anchored point will be the point in which it is anchored too. For example, if the Blue
point is anchored and only 1 unit right to the Green point then the relative coordinates of the Blue point will
be (1,0). Hint: Double click on the specific color's (x,y) to modify.

Note: Sync view can be applied to all views and will not interfere with 'Auto Picture' feature.

Note: Tool will accept a template file path as a key-in parameter. Ex: "TopoDOTApp Breakline
P:\Projects\Route 7\template.rcf"

Note-hotkey: Hold SHIFT to restrict movement to vertical, Hold CONTROL to restrict movement to
horizontal. This applies to the movement of the template or a specific template point.

Note-hotkey: Use the bracket "[" and "]" hotkeys for moving the viewpoint to the next/previous available
template point. This will help significantly if a template (or feature/profile) has relatively large dimensions,
such as an entire highway or bridge profile.




Undo |}f_-fset|:-osition| 4 b ,_;"FIipTempIate| |“' Load Image| BestFit | Auto

Template | Options

Color Level (X,Y) Commands | >ave/Lload
Red Flow Line 0,0 | Move Template | Save
Green Top of Curb (0.813. 2.686) Set || Clear W|
Blue Back of Curb (0.433, 0) Set Clear
Cyan Edge of Pavemert (0.772, -2.567)  Extract
Orange Break: Line (0, 0)
Magenta Break Line 2
White Break Line 3

Adjusting Template coordinates when anchored

How To’s
To Extract a Break Line

1. Isolate a region of data which includes the break line to be extracted.
2. Place a quick poly-line along the break line. This line will be the path or guide-line for the tool to run
along. A quick way to place a line is using Point Snap
e Make sure the path is parallel and close enough (Dimension settings relates to path) to the
break line.

e As you progress you will notice that you can also use a common centerline such as a paint
stripe for most the project. This is useful when working with highway corridors or long straights
of road with uniform profiles.

3. Open the Break-Line Extraction tool.

e Depending on which type of break line (curb, barrier, wall) is being extracted, adjust settings
within the 'Options’ tab to match this type of feature.

e Enable 'Connect Lines' and 'Draw Points' to add lines and points to the design file while
extracting. Recommended

¢ Adjust Data Dimensions to encompass the entire profile of the break line. Optional


http://www.certainty3d.com/wiki/index.php?title=Point_Snap
http://www.certainty3d.com/wiki/index.php?title=File:Break_Line_Extraction_templateCoordinate.png

e Disable 'Clip Data' to avoid clipping while tool moves down path. Optional
e Read other options within the Tool Settings to get familiar with all features.
4. Select guide-line, and then click 'Start'. This action sets the tool along the path. This position will be
at the beginning of the path.
e To get a better preview, the position may be moved to a different location where data is better.
Do this by clicking 'Set Position' and clicking the new location/position along the guide-line.
5. Now establish a template to fit the data. These template items will be placed in the tool preview
where there is a cross section of the break line.
e Click 'Move Template' and place the first point within the preview. This point will be the anchor
point, in which all other points are slave to its movements
e Click 'Set' for the next template item, and place within the preview.

e Continue to place other template points by moving down the list: clicking 'Set' and placing in the
preview.

e Adjust the 'Level' name to the corresponding template point.
¢ Now that the template is created, click 'Save' to create a .rcf file for future use. Optional

6. It's time to start extraction.

7. Click 'Set Position' to move tool to a starting location, or simply click 'Start' to move to the beginning
of the guide-line. This will display a new cross section of the break line within the tool preview

8. Within the tool preview window, click on the anchor point (Red template point) and now move the
template. Move the template to the data and match it to the profile of the break line.

e The template may not fit perfectly, so if adjustments need to be made then click on another
template point and move to data. This movement is done within the preview window of the tool.
Optional

1. While moving a point, the user can hold 'Shift' to lock any movement to a vertical
direction (OR) hold 'Control' to lock movement to a horizontal direction. Optional
2. Use a combination of the Zoom, Grid, and Anchor settings while placing these
points. Optional
9. Now that the template is fit for the first position, click 'Accept’ to place these template points within
the design file.

e The tool automatically moves to the next location (at the specified 'Step' value) and gives you a
new cross section of the break line.

1. If preview is bad, move position by clicking 'Set Position' and click on guide-line or using
the 'Slider Bar'. Optional

2. User can 'Skip, Flag, or Undo' at this point. Optional
e Continue to move template in-order to match the data profile and accepting
10.1f the tool is closed or restarted or started on another guide line, this will create a new extraction
process; therefore, there will be no more interaction between the new break line and first break line.
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View 1 - Top, Default Default

Preview of the break line profile will appear here. This is
based on the path and location on path (where the ACS is)

Auto

First:

Create guide-line
or path for tool to
move along

*" Preveiw of template
within the design file

Then: Click 'Set’ and place other

template pts individually \\)

Finally: Once template is fit; S
click; ‘Accept’. This-will place~ " 3

template in the design file.and .- - «— Guide Line reference
move to the next position:

First: Move Anchor Paint
to correct location on profile

X ‘ BestFit | Auto

Og

i
! Line

of Pavement

Preview of template
within the design file eak Line 2
at 1st position Line 3

to 2nd Location
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ew1 - Top, Default

2nd Location

Then: Click 'Accept’ and move
on'to the 3rd location. ——————>

/

1st Location (Template has been
placed within the design file)

-

2nd Location|(Profile)

t

First| Fit template to data. Move anchor
pointlfirst, and others will follow

BestFit = Auto

Default

D %

Break-line Extraction. X: -0.735 ¥: 1.215.

1

BestFit  Auto

Top of Curb
Back of Curb
of Pavement

Line




Results of the Break Line Extraction

Qriginal
Guide-Line

Back of Curb

.

e
“"h.. \
\ Top of Curb

Edge of Pavement / Flow Line

Results: Template points have been placed as CAD pts and
these pts have been connected with CAD lines




Drape Element to Data

Purpose

Drapes a polyline or shape element down to the point-cloud-data elevation at specified intervals or at
defined vertices/handles. Missing data (such as shadowing around a building) can also be accounted for
with the interpolation feature of this tool.

Step 1 | Step 2 | Step 3 ! |
Interval: Checking the data

Thickness: }( View: Remove Initial Line
Offset: Segment: Remave Points

Extraction Mode:

Nommal v “»Next Segment « Create Line

Slope Limit: : 4 PrevSegment

[ ] Slice Data Vertices

[ ] Keep End Points

[ Key Points ~4- Add Points
Flatten

[ ] Interpolate Missing

[ ] Load Data Dynamically

Scan Distance:
% Process

Drape to Data Step 1 Drape to Data Step 2 Drape to Data Step 3

NOTE: While operating on a single line, the tool must be used from step one to step three. 1) Is to specify
options and execute, 2) Is to QAQC line segments, 3) Is to apply results.

NOTE: While operating on multiple lines, the tool will automatically apply results when 'Process' has been
clicked; therefore, there will not be a step 2 or 3 involved when processing multiple lines at once.

NOTE: 'Add Points' within step 2 can be used when: the draping requires an extra node, there is missing
data, the data is too complex/noise.

NOTE: Tool will now properly drape shape elements so that it retains the shape element type (shape will
remain closed).

Tool Settings

Step 1
Tool Settings Effect
Interval Spacing between processed points
. Thickness of data to look at for calculating the ground level. This will be width and length
Thickness :
along selected line.



http://www.certainty3d.com/wiki/index.php?title=File:DrapeToData_Menu1.png
http://www.certainty3d.com/wiki/index.php?title=File:DrapeToData_Menu2.png
http://www.certainty3d.com/wiki/index.php?title=File:DrapeToData_Menu3.png

Offset the data to look to the left or right. The X-axis of the ACS is a positive value. Will

Offset show the preview sample on the start and end of the element being processed.
. Change extraction method: Normal (averages the whole sample), center-weighted (data
Extraction s : : :
within center of sample have greater effect on the average), low point, or high point for
Mode :
the data sampling method.
- Removes isolated points that exceed the specified slope. This slope is based on a
Slope Limit .
horizontally flat reference.
. Takes a cross-section or slice at every interval. If enabled, this will override any cropped
Slice Data X ; ;
point cloud information.
Vertices Forces tool to calculate an elevation at all vertices of the selected element.
Keep End When enabled, the start and end points of the element are not moved. Does not modify
PoinF:s the ends of the selected poly-line or shape. You'd do so if the beginning and end of your

line tie into existing line work that is already correct (in elevation and horizontal).

Plots key points so that straight/flat sections receive a low amount of points and sections
Key Points of change receive a higher amount of points. The text box is for the XY&Z tolerance
values. The tool will point(s) once it deviates out of the specified tolerance.

When enabled, measurements will be taken vertically instead of perpendicularly to the
reference line. So, if 'Flattened' then the sample will be projected down vertically to the

Flatten data. Recommended to do this when working with a tilted line. If the line is already flat
then there will be no difference between enabled or disabled.
Interpolates an elevation on vertices/handles/intervals with missing data. The linear-
Interpolate : : . . X . . i
Missin interpolation will use available neighboring point elements to calculate the elevation on
9 points with missing data.
Load Data Loads relevant data inside the cross section and unloads any un-relevant data. This is

Dynamically generally used where data has yet to be loaded on a feature.

Determines the relevance of scan data based on the specified distance from the scan

Scan Distance o X
position to the cross section.

Process Activates the tool and processes the selected line.
Step 2
Tool Settings Effect
View The desired view used to display the current cross section or ACS orientation.

A segment is a region from one handle/node to the next on a poly-line. The value
Segment displays the current segment being examined. The current segment will be highlighted
within the design file.

Next/Previous Navigate to the next/previous segment. This feature will NOT work on B-Splines and a
Segment manual check will be required.
Allows the user to insert a Temporary point for the element/polyline to be draped to.
Add Point This is essentially like manually inserting drape points one at a time for the current
segment.




Step 3
Tool Settings Effect
Remove Initial | Will remove the original/initial line once draping is complete. In its place, a newly draped
Line line will be created.
Remove Will remove the Temporary Points used for visual inspection. These are the green, red
Points and blue points. Keep these if you need point elements instead
. Activates the creation of a newly draped line and will carry out any enabled features
Create Line i
within Step 3.
How To’s
http://www.certainty3d.com/university/training/beginner/B106

To Drape an Element

N

S

~

Open the 'Drape Element to Data' tool
Specify the settings that you wish to use prior to running the tool.
Select the line that you wish to drape. Select 'Process'.

e This tool can now properly drape shape elements. The shape will be draped while remaining
closed.

With the line still selected, move to the 'Step 2' tab. This is the QA/QC phase of the tool.
Specify which view you wish to see the cross section in from the "View' input box.
Click on 'Next Segment' and examine the cross section view and verify that points have been placed

correctly. Simply add, move or delete points as needed. This feature of moving down segments will
not work on B-Spline elements.

e Green points signify that points were placed with no error.

¢ Red points signify that there was noise or lack of data involved in the elevation calculation.
e Yellow points signify that there was a large deviation in the points' elevation.

With the point placement verified, move on to the 'Step 3' tab.

Select the options you wish to use and select ‘Create line'. This will create a new line with a node at
every elevation point calculated from the tool.


http://www.certainty3d.com/university/training/beginner/B106/
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Step Extraction

Purpose

This tool is designed to generate 3D poly lines representing a set of steps (or staircase) in one direction
only. The staircase can be square, rectangular or trapezoidal in form (from top view). The rise and run needs
to be linear or maintain a constant slope. This will not support a curved or arched staircase or a multi-pitch
staircase...yet :-)

Here is a quick Video on how to use the tool: Step Extraction Tutorial

Level: |Stairs W

Step Edge Offset:

Tool Interface

Tool Settings

Tool
Settings Effect
Level Define what level to output the stair line-work to.

Step Edge This will be the horizontal distance between the back of the first step and the top of the next
Offset step. The direction of this measurement is parallel with the direction of inclination.

Note: If the stair poly lines are going to be used as a part of the DTM surface, makes sure the offset value
stays positive and is larger than zero.

How To’s
Here is a quick Video on how to use the tool: Step Extraction - Tutorial

To Generate a set of 3D Steps

1. Isolate the stair case so you can clearly see from a top view. Make sure the center of the staircase is
clear of noise.

2. Activate tool by clicking icon.

3. Click on all 4 corners of the staircase. Make sure that the 1st and 2nd click are on the side of the
staircase (see image below).

e« Then move the cursor to the first step face and click to have the first step drawn.
¢ Then move cursor to the second step face and click. Proceed to the next step until the end.
4. Once done locating faces of steps, right click to end the tool.


https://youtu.be/NiUW54If0Z4
https://youtu.be/NiUW54If0Z4
http://www.certainty3d.com/wiki/index.php?title=File:Step_Extraction_Settings.PNG
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Step 1. http://certainty3d.com/university/

Step 2. Create a username and password

Please login to view C3DU customer canu
resources

Certainty 3D University

What is C3DU?

C3D university is a web-based self-taught program
available to our existing customers. Watch

FEEsTaErd TopoDOT® application videos, download data and
practice at your own pace. Perfect for learning new
tricks, educating new personnel or just keeping
your TopoDOT® skills sharp. Just email or contact
support with any questions.

Username

Remember Me

Forgot your password?

Contact Us
Register a new username

Feel free to contact us with any questions you may
have. Our office is open 9 AM - 5 PM EST, Monday -

Public resources Friday.
xR Vebinars 407-248-0160
Brush up on some TopoDOT® .
/ techniques and learn about new support@certainty3d.com
functionality in our Extracting Value

series.

Step 3. Click on C3D Wiki

C3D Wiki

View our comprehensive and always up-
to-date tool manual

Step 4. This is the main page
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Wi Help Welcome to the Certainty 3D Wiki.

Tool Support
TopoDOT Tools
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Special pages

e #) TopoDOT®

Page information

« Introduction

« Installation

« Updating
« Change Log x86
« Change Log x64

« Toolbox Reference
+ Tool Index

« Technotes

“This page was lsst modified on 26 April 2016, st 14:15.

Privacy policy About Certainty 30 Wiki Disclsimers

Contacts

£156.62.133.8 Talk for this IP address Login

Read | View source View history |Search Q

« For TopoDOT tool support: use the search bar to find the tool in question or 100k in the TopoDOT Tool Index
« Have a question or input on a specific tool? On the oo page, add a comment on the discussion tab!

TopoPLAN

Project Planning

= TopoPLANNER
« TopoMISSION

(81 et

For any questions, suggestions, or problems with this document please contact the ODOT Office of
CADD and Mapping Services by use of the following form on the ODOT website:

https://odot.formstack.com/forms/cadd servicerequest



https://odot.formstack.com/forms/cadd_servicerequest

	Intent
	Preparation
	Workflow
	Leica Infinity
	Opening a Project in Leica Infinity
	Importing Raw Data
	Google Earth Check
	Fixing a Wrong Setup
	Preliminary Data Clean-Up (Use with Caution)
	Exporting to LAS

	Remote Desktop Connection
	TerraScan Point Cloud Editing
	Establishing the Remote Desktop Connection
	Opening Microstation
	Starting Terrascan
	Read Points in TerraScan
	Running a Macro for Auto-Classification
	Manual Editing
	Classify Brush
	Vertical Cross Section Tool

	Scaling Point Clouds
	Custom User Defined Transformations
	Applying Transformations

	Exporting Processed Point Clouds

	3DReshaper
	Loading Point Clouds Into 3DReshaper
	Creating a Mesh
	Exporting a Mesh
	Change Detection Models
	Volume Calculations

	Microstation
	Hybrid Terrain Generation
	Workflow

	Importing Meshes
	Generation of TIN from Point Cloud
	Creating a Complex Terrain Model

	TopoDOT
	Importing LAS files
	File Settings (Checking Units)
	Purpose
	Tool Settings
	Load Aerials
	Purpose
	Tool Settings
	Load Aerials


	How To’s
	To Transfer Aerial into Micro Station view
	To Transfer Detailed-Tiled Aerial Images into Micro Station view
	To Utilize Street View
	To Save Aerial Image for future Rastering into Micro Station
	To Create a Custom Coordinate System
	To Raster a Saved Aerial Image into Micro Station
	To Remove Aerials from working view

	Bridge Clearance Tool
	Purpose

	Tool Settings
	Sample Options

	How To’s
	To Measure Bridge Clearances
	To measure Wire to Road Clearances

	Wall Monitor
	Purpose
	Tool Settings
	All Tabs- At bottom of tool
	Data Tab
	Lateral
	Settlement
	Levels Tab
	Options

	Pre – How To’s
	Lateral Movement Cases:
	Settlement Movement Case:

	How To’s
	Method 1:
	Extracting a Grid of Colorized Spots on an Ordinary Wall Surface (Gradient based on deviation)

	Method 2:
	Extracting Lateral and Settlement movement using CSV Stationing file for Panel-Retaining Walls


	Beams
	Purpose
	Tool Settings
	How To’s
	To Create Beams based on measured Dimensions


	Break-Line Extraction
	Purpose
	Tool Settings
	Break Line Extraction Interface
	Template Tab
	Options Tab
	How To’s
	To Extract a Break Line


	Drape Element to Data
	Purpose
	Tool Settings
	Step 1
	Step 2
	Step 3

	How To’s
	To Drape an Element


	Step Extraction
	Purpose
	Tool Settings
	How To’s
	To Generate a set of 3D Steps


	WIKI Page
	Steps to get on Wiki page


	Contacts

